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Thank you for downloading the PENTAX REMOTE Assistant.
This document is the Operating Manual for the PENTAX REMOTE 
Assistant. In order to get the most out of the functions of your PENTAX 
REMOTE Assistant, be sure to thoroughly read this manual before using 
it. Read it together with the Operating manuals for your camera  
and the PENTAX PHOTO Browser/PENTAX PHOTO Laboratory.
After reading the Operating manual, be sure to keep it in a safe place; it 
will come in handy when you want to learn more about the various 
functions.

Regarding trademarks
CompactFlash and CF are trademarks of SanDisk Corporation.
PENTAX is a trademark of PENTAX Corporation.
PENTAX REMOTE Assistant, PENTAX PHOTO Browser, and PENTAX 
PHOTO Laboratory are trademarks of PENTAX Corporation.
All other brands or product names are trademarks or registered 
trademarks of their respective companies.

Symbols used in this manual have the following meanings:

The screen pictures shown in this manual may differ depending on the 
type of computer used.

Gives page numbers explaining related operations.
Gives information that is useful to know.
Gives cautions and notes about the operation.
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What you can do with the PENTAX 
REMOTE Assistant

The PENTAX REMOTE Assistant is software that allows you to operate/
control your digital camera from your computer via a USB cable 
connection. You can control everything from your computer from making 
settings to taking pictures all while checking it on your computer. And the 
pictures will be saved on your computer.

For example, if you were using identical lighting conditions to shoot a large 
number of product photos, you could set the camera on a tripod and simply 
change the products and shoot them one after another, without ever 
touching the camera. The photos are displayed on the screen, so you can 
check and then save them.
If you use the Assistant in conjunction with the PENTAX PHOTO Browser 
and/or the PENTAX PHOTO Laboratory, you can do everything from your 
computer, from making camera settings and taking photos to managing 
images-all in one continuous flow.

If you use it on your laptop, you can take it outdoors, giving yourself all the 
more freedom for taking pictures and managing them.

What’s more, when you use the PENTAX REMOTE Assistant, the 
following two Optional functions can be used in addition to your camera’s 
normal shooting functions.

Interval/Timer Shooting
You can take pictures with a lot of flexibility when you use the Interval and 
Timer settings.

Expanded bracket shooting
The refined settings in Auto-Bracketing make shooting a snap.

You can also start up the PENTAX PHOTO Browser, the PENTAX 
PHOTO Laboratory, or the PENTAX REMOTE Assistant individually.

• This manual explains how to make settings to your camera, take pictures, etc. 
with the PENTAX REMOTE Assistant. For more detailed information about 
your camera’s settings, functions, how to view through the viewfinder display 
guide, etc., please refer to your camera’s operating manual.

• For information on how to operate the PENTAX PHOTO Browser and/or the 
PENTAX PHOTO Laboratory, please see the PENTAX PHOTO Browser/
PENTAX PHOTO Laboratory operating manual(s).

• We recommend using an AC adaptor when connecting your camera to a 
computer.
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We recommend the following system environment when using the 
PENTAX REMOTE Assistant.
• OS: Mac OS 9.0 or high (CarbonLib 1.5 or later)

Mac OS X 10.1.3 or later
• CPU: Power PC G3 or later
• Memory: 256MB or more
• Monitor: 1024 × 768 in 24 bit full color

(approx. 16.77 million colors)
• Free Disk Space: 70MB or more
• The OS is pre-installed, and then the USB port must be standard 

equipment.

The System Environment

• In Mac OS 8.6, you cannot use PENTAX REMOTE Assistant.
• We recommend using an AC adaptor when connecting your camera to a 

computer.
• In order to use the PENTAX REMOTE Assistant, it is necessary to update 

your camera’s firmware to version 1.11 or later.
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Starting up the PENTAX REMOTE 
Assistant

Start up the PENTAX REMOTE Assistant. You can start it up by either 
launching it from the PENTAX PHOTO Browser or by starting it up from 
your computer independently.
Before starting the program, connect your camera and computer with the 
USB cable and turn the camera ON.

1 In the PENTAX PHOTO Browser window, select [PENTAX 
REMOTE Assistant] from the Tool menu.
The PENTAX REMOTE Assistant will start up.

We recommend using an AC adaptor when connecting your camera to a 
computer.

Starting up from the PENTAX PHOTO Browser
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1 Double-click the [PENTAX Digital Camera Utility] on the 
hard disk.

2 Double-click the [PENTAX REMOTE Assistant] program 
icon.
The PENTAX REMOTE Assistant will start up. If your camera and 
computer are connected, the following [PENTAX REMOTE Assistant] 
screen will be displayed.

1 Select [Quit] from the [File] menu.
The PENTAX REMOTE Assistant finishes and the [PENTAX REMOTE 
Assistant] window closes.

Starting up from the program icon

Closing the PENTAX REMOTE Assistant

For information about how to disconnect a camera, refer to P.15 of the 
PENTAX PHOTO Browser operating manual.
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The Structure of the PENTAX REMOTE 
Assistant Window

If you start up the PENTAX REMOTE Assistant while your camera and 
computer are connected, the following [PENTAX REMOTE Assistant] 
window is displayed.

Status bar

Viewfinder 
Indicators

Tool bar

Release button



8

Viewfinder Indicators
The viewfinder indicators that are displayed when viewing through the 
camera’s viewfinder appear underneath the menu and tool bar.

For detailed information about the viewfinder indicators, refer to your 
camera’s operating manual, P.17 “Viewfinder Indications”.

Status Bar
The name of the lens currently being used is displayed on the status bar 
at the very bottom of the screen.

Release Button
When you click the release button, the camera's shutter release button is 
operated and a photo is taken.

The menu bar has four pulldown menus, File, Operation, View, and Help. 
The contents of each menu are as follows.

Viewfinder Indicators/ Status Bar/ Release 
Button

You cannot check the subject before shooting taking picture with the Viewfinder 
Indicators in the PENTAX REMOTE Assistant window. Carry out operations 
like checking the subject with the camera itself.

If you select the shutter release from the [Operation] menu, you cannot perform 
Consecutive Shooting or Bulb shooting.

Menu Bar
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File Single shooting 
mode

Takes one photo at a time and saves it.
P.14

Buffer selection 
mode

After taking a number of photos, they are put 
together, allowing you to save or delete them.

P.15
Auto save mode When photos are taken then are automatically 

saved in a set location.
P.17

Optional settings Settings are made for things like the location and file 
names when using the Auto-Save mode or AF 
operation with Remote Release, etc.

P.17
Quit Closes the PENTAX REMOTE Assistant.

P.6

Operation Shutter release Presses the camera's shutter release button, taking 
a picture.

P.19
AF execution Allows focusing (when the shutter release button is 

pressed halfway down or AF button is pressed) 
during Auto-focus.

P.71, P.78 of operating manual for your camera.
AE lock Sets the exposure setting prior to taking the 

photograph
P.69 of operating manual for your camera.

Green Button Presses the Green Button, to obtain the correct 
exposure.

P.66 of operating manual for your camera.
Measure manual 
white balance

Allows you to set white balance manually.
P.23
P.142 of operating manual for your camera.

Remote Interval/
Bracket shoot

Displays the [Remote Interval/Bracket shoot] 
window for setting and shooting with Interval 
Shooting/Timer Shooting and extended bracketing 
shooting (high level Auto-Bracketing Shooting).

P.26
P.82 of operating manual for your camera.

Custom Function Displays the [Custom Function] window for making 
custom function settings. You can save the settings 
and recall them.

P.32
P.115, P.127 of operating manual for your 

camera.
Camera menu 
screen window

Displays information about the settings menu for 
the camera. You can make changes while in this 
screen to the settings.

P.30
P.112 - P.126 of operating manual for your 

camera.
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The tool bar is set up with buttons of frequently used functions (menu 
items). By just clicking one of the tool bar buttons, you can operate its 
corresponding function. Once you get used to it, you will find it easier to 
operate this way.

View Detailed 
viewfinder 
display

Displays detailed viewfinder indicators.

Simple 
viewfinder 
display

Displays simplified viewfinder indicators.

Line up 
window

Arranges and displays open [Shooting condition set 
window] and [Camera Setting window].

Toolbars Displays the tool bar under the menu.
Status Bar Displays the status bar at the bottom of the screen.
[Shooting 
condition set 
window]

Displays [Shooting Condition set window].
P.20

[Camera setting 
window]

Displays [Camera setting window]
P.22

Help Version Displays version information.

Tool Bar

If you put the cursor over a tool bar button (item), the name of the item is 
displayed.
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For information about each button on the tool bar, please refer to the 
“Menu Bar” (P.8).

1. Single shooting mode Same as the corresponding item in the [File] 
menu.

2. Buffer selection mode

3. Auto Save mode

4. AF execution Same as the corresponding item in the 
[Operation] menu.

5. AE lock

6. Green Button

7. Remote Interval/Bracket 
shoot

8. Custom Function

9. Camera menu screen 
window

10. Optional settings Same as the corresponding item in the File 
menu.

11. Help Same as PENTAX REMOTE Assistant Help 
in the [Help] menu.

2. Buffer selection mode

1. Single shooting mode

3. Auto Save mode 11. Help

5. AE lock

10. Optional settings6. Green Button

7. Remote Interval/
Bracket shoot

9. Camera menu screen widow

8. Custom Function4. AF execution
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 Basic Operation for Taking Pictures 
(Quick Start)

With the PENTAX REMOTE Assistant you can operate your camera from 
making various settings for the shooting conditions to taking pictures 
(shutter release) by your computer. The basic operations for taking 
pictures are explained here.

The only difference between using the PENTAX REMOTE Assistant for 
shooting and normal release shooting is connecting the camera to a 
computer. Bear the following points in mind while getting ready to take 
pictures. Refer to the PENTAX PHOTO Browser operating manual on 
P.13 for information about connecting your camera to a computer.

We recommend using an AC adaptor when connecting your 
camera to a computer.

Decide where to place your camera based on the positions of the 
subject and your computer, and fix it in place using a tripod or the 
like.

In addition to the positions of the camera and the subject, position the 
camera so the connection to the computer is easy to make and so it will be 
secure.
As it is not possible to check the composition of your subject in the 
PENTAX REMOTE Assistant window before shooting, make any 
adjustments while looking through the camera's viewfinder.
If you use a laptop computer, you will have a great deal more freedom in 
positioning, and being able to shoot outdoors.

For detailed information about your camera's functions, such as drive modes, 
image quality, focusing, exposure, the strobe, light metering method, etc., refer 
to operating manual for your camera.

• We recommend using an AC adaptor when connecting your camera to a 
computer.

• When your camera is connected to a computer via a USB cable, the Auto 
Power-off (Power saving function) does not work.

Getting Ready to Shoot
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Decide on where to save the data of the pictures you take.

We recommend to decide where to save your picture data in advance so 
you won't forget afterwards. If you are taking a lot of pictures, check to 
make sure you will have enough space free where you wish to save them.

You can check your camera’s current settings and make any changes 
needed in the [Shooting Condition set window] or the [Camera Setting 
window] with the PENTAX REMOTE Assistant.
However, it is not possible to check the positioning or size of your subject 
in the [PENTAX REMOTE Assistant] window. Make any adjustments by 
looking through the camera’s viewfinder.

Also, as the following items cannot be set with the PENTAX REMOTE 
Assistant, make the settings on the camera itself. For detailed information 
about the settings and how to make them, please refer to your camera’s 
operating manual.

 Capture mode
P.59 of operating manual for your camera.

 Metering mode (Metering Method)
P.57 of operating manual for your camera.

 Focus mode
P.70 of operating manual for your camera.

 Focus Point (Focus Point) Mode: (AUTO/SEL/  )
P.74 of operating manual for your camera

Making Settings on the Camera Itself

For information about the [Shooting condition set window] and the [Camera 
setting window] of the PENTAX REMOTE Assistant, refer to the Settings for 
Shooting (View Menu) (P.20).
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The following three modes exist for taking and saving pictures with 
PENTAX REMOTE Assistant. Select the mode from the [File] menu or on 
the tool bar and then take a picture.

 Single shooting mode
Takes one photo at a time and saves it.

 Buffer selection mode
After taking a number of photos, they are put together for processing, such 
as saving or deleting them.

 
Auto save mode

When photos are taken they are automatically saved in a set location. The 
rules for naming files, and the destination folder when using [Auto save 
setting] are set in [Optional settings] of the [File] menu.

In this mode one photo is taken at a time and then saved.
When you take a picture in this mode, the shot you have taken is displayed 
in the PENTAX REMOTE Assistant window as follows.

Making Environmental Settings in PENTAX 
REMOTE Assistant ([File] Menu)

Single Shooting Mode
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At the same time, the following [Save] dialog box is displayed. You can 
alter the file name or the destination folder here. Once you click [Save], the 
file is saved in the specified destination folder under the specified file 
name.

In this mode, after taking a number of photos, they are put together for 
processing, such as saving or deleting them. Once you select this mode, 
the [Camera buffer] window is displayed.
The pictures you take are displayed in order in the [Camera buffer] window 
as follows.

• If you click [Cancel] on the [Save] dialog box, or forcefully close the dialog 
box, the picture cannot be saved. So, take care with this.

• If the camera’s power goes OFF, any unsaved pictures will be lost.

The default file names and destination for saving shown in the [Save] dialog 
box are according to the contents of the settings made in the [Optional settings] 
of the [File] menu.

Buffer Selection Mode



16
There are tool icons under the title bar on the [Camera buffer] window. 
Once you select a desired picture and click the tool icon, you can employ 
any of its processes-saving, deleting, etc.

Selecting a Picture
As you check the boxes (  ) above each of the pictures, a check mark 
appears and the picture is selected.

• When the [Camera buffer] window is being displayed, if you switch to either 
the Single shooting mode or the Auto save mode, the [Camera buffer] window 
will close and you will not be able to save the pictures you have taken.

• If the camera’s power goes OFF, the contents of the buffer will be lost.
• When the camera is in the Buffer selection mode, your picture data is 

temporarily stored in the camera’s internal buffer memory, so if the buffer 
memory becomes full, you will not be able to take any more pictures. Save 
the data to files at the appropriate time.

• When the Noise Reduction function of the Custom Settings is On, you can 
take up 5 pictures.

P.115, P.127 of operating manual for your camera.
P.32
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 Selecting all the Pictures (Select All)
You can select all the pictures by clicking this icon.

 Saving Pictures (Capturing)
This saves selected pictures. The [Save] dialog box appears for each 
picture; once you click [Save], a file is saved in the specified destination 
folder under the specified file name.

 Deleting Pictures (Deleting Specified Pictures)
This deletes selected picture(s) from the buffer. Deleted pictures 
disappear from the [Camera buffer] window.

 /  Enlarging/Shrinking the Size of Windows (Expanding/
Shrinking)
You can display the [Camera buffer] window with an enlarged/shrunk 
header & footer. When it is shrunk, you can use the scroll bar to display 
your pictures.

When photos are taken they are automatically saved in a set location. The 
rules for naming files, and the destination folder when using Auto-Save are 
according to the settings in [Optional settings] of the [File] menu.

Settings are made for things like the location and file names when using 
the Auto save mode or AF operation with Remote Release, etc.
If you select [Optional settings] from the [File menu] (or from the tool bar), 
the following [Optional settings] window appears.

The default file names and destination for saving shown in the Save 
dialog box are according to the contents of the settings made in the 
Environmental Settings of the File menu.

Take care as once a picture is deleted, it cannot be recovered.

Auto Save Mode

Optional Settings
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Auto-save setting — Folder to be saved/Base file name/Sequential 
number figure
This sets the folder in which files will be saved, the text at the beginning of 
the file name and the number of digits for consecutive numbering at the 
end of the file name, which will be used in the Auto save mode.
The default values set here are also followed in the Single shooting mode 
and when saving files in the Buffer selection mode.

AF with Remote Release
Choose whether or not to activate the operation of AF (auto-focus) when 
taking pictures by clicking the Release button.

After making settings for each item, when you click the [OK] button, the 
settings are saved and the [Optional settings] window is closed.

The basic procedures for taking pictures are explained here.
After positioning your camera, connecting to the computer and starting up 
the PENTAX REMOTE Assistant, use the following procedures to take 
pictures.

1 Make any adjustments to the size of your subject and its 
position while looking through the camera’s viewfinder.
• P.39 of operating manual for your camera.

Taking Pictures

• For information about the PENTAX REMOTE Assistant’s [Shooting condition 
set window] and the [Camera setting window], refer to Settings for Shooting 
(View menu/Operations menu) (P.20).“Settings for Shooting ([View] menu/ 
[Operation] menu)” (P.20)

• For more detailed information about settings for shooting conditions or other 
camera operations, please refer to the operating manual for your camera.
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2 Make settings such as capture mode, metering method, 
focus mode, focus point mode (AUTO/SEL/ ), etc. on the 
camera itself.
• Capture Mode : P.59 of operating manual for your camera.
• Metering method : P.57 of operating manual for your camera.
• Focus mode : P.70 of operating manual for your camera.

• Focus point mode (AUTO/SEL/ ) : P.74 of operating manual 
for your camera.

3 Select a mode (Single shooting/Buffer selection/Auto 
save) from either the [File] menu of the PENTAX REMOTE 
Assistant or the tool bar.
If needed, make settings to the PENTAX REMOTE Assistant 
environment with [Optional Settings].

• “Single Shooting Mode” (P.14)

• “Buffer Selection Mode” (P.15)

• “Auto Save Mode” (P.17)

• “Optional Settings” (P.17)

4 Check and make changes as necessary to shooting 
conditions settings, etc., with the [Shooting condition set 
window] and the [Camera Setting window].
• “Settings for Shooting ([View] menu/ [Operation] menu)” (P.20)

5 For Auto-focus, select [AF execution] from the [Operation] 
menu (or from the tool bar).

6 Click the Release button in the [PENTAX REMOTE 
Assistant] window.
A picture is taken in the selected mode.
For the Auto save mode, picture data is saved at the same time the 
picture is taken.
In the Single shooting mode and the Buffer selection mode, confirm the 
image to be saved, specify a file name and destination and then save.
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 Settings for Shooting ([View] menu/
[Operation] menu)

You can check and make changes as needed to camera shooting settings 
with the PENTAX REMOTE Assistant. To check or make changes to 
shooting condition or picture quality settings, you can use the [Shooting 
condition set window] and the [Camera setting window].
In addition, it is possible to manually set the White Balance with the 
PENTAX REMOTE Assistant, without touching the camera.

If you select the [Shooting condition set window] from the [View] menu, the 
[Shooting condition] window will be displayed. The content of shooting 
conditions currently set in the camera, such as Exposure Mode, Aperture 
Value, Flash mode, etc., are displayed in the window.

If you switch the Capture mode with the mode dial on the body of the 
camera, switch the metering mode with the metering mode lever, etc., the 
displayed contents will also change.

If you click the 3 of the right of an item, a drop-down list of choices is 
displayed. By selecting a desired value from the list, you can change the 
settings on the camera.

[Shooting Conditions] Window ([View] menu)

• Items that cannot be altered with the PENTAX REMOTE Assistant are 
grayed out.

• You can check the current settings for the [Exposure Mode] and [Metering 
mode] (metering method), but you cannot make changes with the PENTAX 
REMOTE Assistant. Make the settings on the body of the camera.
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For detailed information about each item in the [Shooting Condition] 
window, refer to the appropriate page in your camera’s operating manual.

[Shutter Speed]
P.61, P.62, P.136 of operating manual for your camera.

[Aperture Value]
P.61, P.64, P137 of operating manual for your camera.

[Exposure Compensation]
P.79 of operating manual for your camera.

[Auto Bracketing Exposure]
P.82 of operating manual for your camera.

[Exposure Mode]
P.59 of operating manual for your camera.

Metering mode (=metering method)
P.57 of operating manual for your camera.

AF Point (=focus point)
P.74 of operating manual for your camera.

[Flash mode]
P.86 of operating manual for your camera.

Changes to settings cannot be made with the PENTAX REMOTE Assistant.

Changes to settings cannot be made with the PENTAX REMOTE Assistant.

If you set the Focus point select dial to SEL (=select mode) on the camera 
body, you can make changes to the Focus Area (focus point).

When the flash is up on the camera and can be used, it is possible to make 
changes to the [Flash mode].
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[White Balance]

P.55, P.142 of operating manual for your camera.
“Manual White Balance Metering ([Operation] menu)” (P.23)

If you select [Camera setting window] from the View menu, the [Camera 
settings] window will appear.
The [Camera settings] window displays the Drive mode, File format 
(Quality), Recorded Pixels, etc., and the current shooting, quality, etc., 
settings for the camera.

If you switch the Drive mode with the Drive Button on the body of the 
camera, or change the recording size or quality etc., the displayed 
contents will also change.

If you click the 3 of the right of an item, a drop-down list of choices is 
displayed. By selecting a desired value from the list, you can change the 
settings on the camera.
For detailed information about each item in the [Camera settings] window, 
refer to the appropriate page in your camera’s operating manual.

[AF area mode] (=focus point mode : AUTO/SEL/  )
P.74 of operating manual for your camera.

Camera Settings Window ([View] menu)

• Items that cannot be altered with the PENTAX REMOTE Assistant are 
grayed out.

• You can check the current settings for the [AF area mode] (focus point mode: 
AUTO/SEL/ ) and the [Autofocus mode], but you cannot make changes 
with the PENTAX REMOTE Assistant. Make the settings on the body of the 
camera.
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[Autofocus Mode]
P.70 of operating manual for your camera.

[Drive mode]
P.44 of operating manual for your camera.

[File format] (=Quality)
P.52 of operating manual for your camera.

[Saturation]
P.117 of operating manual for your camera.

[Sharpness]
P.117 of operating manual for your camera.

[Contrast]
P.118 of operating manual for your camera.

[Recorded Pixels]
P.51 of operating manual for your camera.

[Sensitivity]
P.54 of operating manual for your camera.

You can use the PENTAX REMOTE Assistant to set the White Balance 
manually by following the procedures below.

Changes to settings cannot be made with the PENTAX REMOTE Assistant.

Changes to settings cannot be made with the PENTAX REMOTE Assistant.

Manual White Balance Metering ([Operation] menu)

• In order to reproduce subtle colors under the lighting conditions in which you 
are shooting, a baseline white is metered, and then you can make manual 
settings for up to three types. This setting is called Manual White Balance.

• For more detailed information about White Balance and Manual White 
Balance, refer to your camera’s operating manual, P.55 and P.142.
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1 Select the [Shooting condition set window] from the 
[View] menu of the PENTAX REMOTE Assistant.
The [Shooting condition] window is displayed.

2 Click the 3 on the right side of [White Balance] in the 
[Shooting condition] window and select one of in the drop-
down list, from Manual 1 to Manual 3.

3 Select Capture mode with the mode dial on the body of the 
camera, and put a sheet of white or gray paper so it 
completely fills up the viewfinder.

4 Select [Measure white balance] from the [Operation] 
menu.
A confirmation dialog box will appear.

5 Click the OK button and check the LCD monitor of your 
camera.

You can set the Manual White Balance to any of the three settings, 1 to 3.
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The camera’s shutter release button is pressed and if the setting is 
correct, the LCD monitor will display [OK].
The following message of will appear on your computer’s screen. Click 
the OK button.
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 Remote Interval/Bracket shoot 
([Operation] Menu)

When you use the PENTAX REMOTE Assistant, the following two 
shooting functions of the Remote Interval/Bracket shoot can be used in 
addition to the normal shooting functions.

Interval/Timer shooting
You can shoot with a great deal of flexibility using the Interval and Timer 
shooting settings. (These functions are not available on the camera body)

Expanded bracket shooting
You can easily make even more exact settings and finer pictures than is 
possible using the settings for Auto Bracketing Shooting that can be made 
with the camera.

Auto Bracketing Shooting: Camera’s operating Manual P.82

The following procedures for Interval shooting allow you to shoot a 
specified number of pictures in a specified interval of time. As a highly 
flexible Timer shooting function, you can also shoot just one picture during 
a specified time.

1 Select [Remote Interval/Bracket shoot] from the 
[Operation] menu of the PENTAX REMOTE Assistant.
The [Remote Interval/Bracket shoot] window is displayed.

We recommend using an AC adaptor when connecting your 
camera to a computer.

• When you use Remote Interval/Bracket shoot, the camera always goes to 
Auto Save mode, so the pictures you take are automatically saved.

• The Auto Save mode remains activated even after you finish Remote 
Interval/Bracket shoot.

Interval/Timer Shooting ([Operation] Menu)

The Timer shooting here differs from the Camera Self-timer Shooting, which 
shoots after about 12 seconds.
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2 Click the Interval/Timer shooting tab in the [Remote 
Interval/Bracket shoot] window.
The settings screen for Interval/Timer shooting will appear.

3 Make the settings for [Time to a start], [Interval Time], and 
[Number of shot].
• Time to a start: Sets the time before starting to shoot (how many 

hours, minutes and seconds before shooting). 
You can set this anywhere in the range from 
zero second to 9 hours, 59 minutes and 59 
seconds.

• Interval time: In the case of interval shooting, this sets the 
interval between shots. You can set this 
anywhere in the range from zero second to 9 
hours, 59 minutes and 59 seconds.

• Number of shot: Sets the total number of shots to take. This can 
be set in the range from 1 to 999 shots. When 
using Timer Shooting, this is set at one shot.

4 Click the [Execute] button.
This executes Interval/Timer shooting according to the settings and files 
are automatically saved.

When you take pictures with interval shooting, the number of missing frames 
due to out of focus by AF.S or other reasons will be displayed at [Number of 
miss shots] after the shooting session.
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With the finer settings, high-level Auto-Bracketing shots are possible.
Auto Bracketing Shooting: Camera’s operating Manual P.82

In addition, you can make changes to not only [Exposure], but also 
[Saturation], [Contrast], and [Sharpness] for shooting your pictures.
Follow the procedures and shoot.

1 Select [Remote Interval/Bracket shoot] from the 
[Operation] menu of the PENTAX REMOTE Assistant.
The [Remote Interval/Bracket shoot] window is displayed.

2 Click the [Expanded bracket shooting] tab in the [Remote 
Interval/Bracket shoot] window.
The [Expanded Bracket shooting] settings screen will appear.

3 Select the parameters you wish to change when you shoot 
from the drop-down [Parameter select] list.
Select [Exposure] when you choose Auto Bracketing Shooting. 
Alternatively, if you change the [Saturation], [Contrast], or the 
[Sharpness] when you take pictures, select the desired parameter.
In the following example, [Exposure] has been selected.

Expanded Bracket Shooting 
([Operation] Menu)

If you select the Green Program mode, [Exposure] is not displayed.



29
4 Set the [Exposure compensation value], [Exposure bracket 
steps], [Shooting order] and [Number of exposure].
• Exposure compensation value:

Sets the exposure compensation value to be used as 
the standard for shooting. Shooting then centers on 
the value set here as (0) and switches between the - 
(under) and +(over) directions. If you do not wish to 
make an adjustment to the standard, select (0).

• Exposure bracket steps:
Sets the width of the exposure adjustments, which 
are changed when you shoot. Shots are taken with 
compensation to exposure according to the value set 
here in the - (under) and + (over) directions. Set a 
value other than 0.0.

• Shooting order:
Sets the order for shooting. 0 = no adjustment, - = 
under side, + = over side.

• Number of exposure:
Sets the total number of shots to take. This can be set 
in the range from three to nine shots (only odd 
number can be entered).

5 Click the [Execute] button.
This executes Expanded bracket shooting according to the settings and 
files are automatically saved.

• If you fail to set the [Exposure bracket steps] to something other than 0.0, you 
will not be able to take pictures.

• If you select a parameter other than [Exposure], (that is, [Saturation], 
[Contrast], [Sharpness]), you can only set the [Shooting order].

• If you select the Green Program mode, you cannot change the value of the 
exposure compensation and the exposure bracket step.

• When the image taken by the Expanded bracket shooting is displayed on the 
PENTAX PHOTO Browser, [Bracket Off] is displayed in the Image data pane.

During shooting a dialog box indicating the status will be displayed. You can 
discontinue shooting by clicking the [Cancel] button on the dialog box.
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 Camera Menu Screen ([Operation] 
Menu)

You can check and make changes as needed to the contents of the 
camera settings menu with the PENTAX REMOTE Assistant. In addition, 
you can check the settings of custom functions (three types) and make 
changes or call-outs as needed.

If you select the Camera menu screen window from the [Operation] menu, 
the [Camera menu screen] window will be displayed.
The content of the settings menu that are currently set in your camera are 
displayed in the [Camera menu screen] window, namely, date/time set, 
world time, language settings, etc.

If you click the 3 of the right of an item, a drop-down list of choices is 
displayed. By selecting a desired value from the list, you can change the 
contents of the camera settings menu.

Camera Menu Screen ([Operation] Menu)
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After making changes, if you click the [OK] button, the contents of the 
settings menu are changed.
For detailed information about each item in the settings menu, refer to the 
appropriate page in your camera’s operating manual.

Date Adjust
• Switch between a 24-hour display and a 12-hour display by clicking 

the radio button (  ).
• Change the date/time by either entering numbers in directly or by 

clicking the up/down buttons on the right side.
P.120 of operating manual for your camera.

World Time
• To activate World Time, check the box of the right of [Effective].
• To activate Daylight Savings Time, check the box of the right of 

[Effective].
P.120 of operating manual for your camera.

Language
P.122 of operating manual for your camera.

Video Out
P.123 of operating manual for your camera.

Brightness Level
P.123 of operating manual for your camera.

Instant Review
P.118 of operating manual for your camera.

Auto Power Off
P.119 of operating manual for your camera.

Beep
P.119 of operating manual for your camera.

File #
P.124 of operating manual for your camera.

Slideshow Interval
P.125 of operating manual for your camera.
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If you select [Custom Function] from the [Operation] menu, the [Custom 
Function] window will be displayed. Custom function information set in the 
camera settings menu is displayed in the [Custom Function] window.

P.115, P.127 of operating manual for your camera.
If you click the [Function #] buttons on the top right of the screen, the 
desired custom function can be called out.
You can switch between pages by clicking the select tabs [Page1] to 
[Page5].

• The firmware version of the camera is displayed on the bottom right of the 
[Camera menu screen] window.

• When you do not wish to make any changes to settings, click [Cancel].

Custom Function ([Operation] Menu)
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If you click the 3 to the right of an item, a drop-down list of choices is 
displayed. By selecting a desired value from the list, you can change the 
settings of the custom function.
After making changes, if you click the OK button, the contents of the 
custom function are changed. In addition, you can save to the settings 
content files, call out from the files, reset them, etc.
For detailed information about each item in the [Custom Function], refer to 
page 127 in your camera’s operating manual.

The following procedures are for selecting and making settings for a 
desired custom function.

1 Select [Custom Function] from the [Operation] menu of 
the PENTAX REMOTE Assistant.
The [Custom Function] window will appear.

2 Select the desired custom function number by clicking the 
numbered button on the top right of the screen.
The content of the settings for the custom function you selected is 
displayed.

3 Click the OK button.
The selected custom function is set and the [Custom Function] window 
closes.

Use the following procedures to make changes to custom function 
settings.

1 Select [Custom Function] from the [Operation] menu of 
the PENTAX REMOTE Assistant.
The [Custom Function] window will appear.

Making Settings to a Selected Custom Function

Changing Custom Function Settings
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2 Select the number of the custom function you wish to 
change by clicking the numbered button on the top right 
of the screen.
The content of the settings for the custom function you selected is 
displayed.

3 Click the tabs, [Page1] - [Page5] to switch among the 
pages and then make changes to the settings of the 
various items.

4 Click the [OK] button.
The changes to the content of the custom function are set and the 
[Custom Function] window closes.

Apart from the 3 custom functions, you can save the current settings to file. 
You can call out and use saved settings from file at any time.
Use the following procedures to save to custom function settings to file.

1 Select [Custom Function] from the [Operation] menu of 
the PENTAX REMOTE Assistant.
The [Custom Function] window will appear.

2 Select the number of the custom function you wish to save 
to file by clicking the numbered button on the top right of 
the screen.
The content of the settings for the custom function you selected is 
displayed.

3 Make any changes needed to current settings.

4 Click the [Save as] button.
The following [Save As] dialog box is displayed.

Saving Custom Function Settings to File
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5 Select the destination to save to, enter an file name and 
then click [Save].
The file is saved in the specified destination under the specified file name 
and the dialog box closes.

6 Click the [OK] button in the [Custom Function] window.
The custom function is set and the [Custom Function] window closes.

You can call out and use the settings you saved to file.
Use the following procedures to read custom function settings from a file.

1 Select [Custom Function] from the [Operation] menu of 
the PENTAX REMOTE Assistant.
The [Custom Function] window will appear.

2 Click the numbered button on the top right of the screen, 
selecting the custom function number for which you wish 
to make settings to file.
The content of the settings for the custom function you selected is 
displayed.

 The file extension .ini is added automatically to the file name.

Reading Custom Function Settings from File
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3 Click the [Recall] button.
The following [Recall] dialog box is displayed.

4 Open the folder where the file was saved, select the 
desired file and click [Open].
The specified file is read and the contents of its settings are displayed in 
the [Custom Function] window.

5 Click the [OK] button in the [Custom Function] window.
The called out custom function is set and the [Custom Function] window 
closes.

You can return settings to the factory default status by resetting the 
settings.
Use the following procedures to reset custom function settings.

 The names of settings files that have been saved end with the file extension 
.ini.

Resetting Custom Function Settings
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1 Select [Custom Function] from the [Operation] menu of 
the PENTAX REMOTE Assistant.
The [Custom Function] window will appear.

2 Select the number of the custom function you wish to 
reset by clicking the numbered button on the top right of 
the screen.
The content of the settings for the custom function you selected is 
displayed.

3 Click the [Reset] button.
The settings are reset, returning them to the factory default status.

4 Click the [OK] button in the [Custom Function] window.
The reset custom function settings are made and the [Custom Function] 
window closes.
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 Working with Related Software

If you use the Assistant along with the PENTAX PHOTO Browser and/or 
the PENTAX PHOTO Laboratory, you can do everything from your 
computer, from reviewing and managing the data of your pictures to 
converting file formats, etc. -all in one continuous flow.
For information on how to operate the PENTAX PHOTO Browser and/or 
the PENTAX PHOTO Laboratory, please see the PENTAX PHOTO 
Browser/PENTAX PHOTO Laboratory operating manual(s).

The PENTAX PHOTO Browser is software for reviewing and managing 
the data of pictures you have taken. It is compatible with the camera’s own 
CCD RAW image data (.pef), TIFF (.tif), and JPEG (.jpg).
You can easily check shooting information, save shooting information as 
a list, simply display RAW image data, etc.

PENTAX PHOTO Laboratory is software for reading and expanding the 
camera’s own CCD RAW image data (.pef), and making fine adjustments/
processing of the tone curve, white balance, etc.
In addition, you can convert and save files to 8 or 16 bit TIFF (.tif) or JPEG 
(.jpg) formats.

PENTAX PHOTO Browser (Image 
Management/Reviewing)

PENTAX PHOTO Laboratory (RAW Data 
Expansion/Conversion)
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Glossary

Exif-TIFF format
Exif stands for Exchangeable Image File Format. This image file format is 
based on the TIFF image data format, and allows thumbnail images and 
image properties to be embedded into the data. Software that does not 
support this format processes the image as a regular TIFF image.
Exif-JPEG format
Exif stands for Exchangeable Image File Format. This image file format is 
based on the JPEG image data format, and allows thumbnail images and 
image properties to be embedded into the data. Software that does not 
support this format processes the image as a regular JPEG image.
CCD RAW data
CCD stands for Charge Coupled Device. A semiconductor device that 
converts optical information into electrical signals. RAW image data is raw 
data recorded from CCD output. This data can be transferred to a PC, and 
manipulated into image data with unique settings such as JPEG and TIFF 
using specialized software.
JPEG
An image compression format. Select INGPE2_C (S. Fine), INGPE2_D 
(Fine), or INGPE2_E (Economy) for image quality, and the image is saved 
in JPEG format. Although the image quality deteriorates a little, more 
images can be saved in the same space.
TIFF
A file format for saving image data. The image is not compressed making 
the file size large, but no deterioration of image quality occurs.
TIFF16
Although TIFF images are usually 8 bit, this is 16 bit TIFF.
One 8 bit pixel can reproduce 256 colors. More computations are required 
when image processing as the dynamic range is larger.
sRGB (standard RGB)
An international color space standard defined by IEC (International 
Electrotechnical Commission). This is specified as a standard color space 
for generic PC monitors and Exif.
AdobeRGB
This color space is recommended for commercial printing and document 
creation by Adobe Systems (US). Its color reproduction range is larger 
than sRGB, and adequately covers the color reproduction range for 
printing. Therefore, color data only reproducible on a printer are not lost 
when editing on the PC. Note: using it with unsupported software causes 
the colors to appear faint.


	What you can do with the PENTAX REMOTE Assistant
	The System Environment

	Starting up the PENTAX REMOTE Assistant
	Starting up from the PENTAX PHOTO Browser
	Starting up from the program icon
	Closing the PENTAX REMOTE Assistant

	The Structure of the PENTAX REMOTE Assistant Window
	Viewfinder Indicators/ Status Bar/ Release Button
	Menu Bar
	Tool Bar

	Basic Operation for Taking Pictures (Quick Start)
	Getting Ready to Shoot
	Making Settings on the Camera Itself
	Making Environmental Settings in PENTAX REMOTE Assistant ([File] Menu)
	Taking Pictures

	Settings for Shooting ([View] menu/ [Operation] menu)
	[Shooting Conditions] Window ([View] menu)
	Camera Settings Window ([View] menu)
	Manual White Balance Metering ([Operation] menu)

	Remote Interval/Bracket shoot ([Operation] Menu)
	Interval/Timer Shooting ([Operation] Menu)
	Expanded Bracket Shooting ([Operation] Menu)

	Camera Menu Screen ([Operation] Menu)
	Camera Menu Screen ([Operation] Menu)
	Custom Function ([Operation] Menu)

	Working with Related Software
	PENTAX PHOTO Browser (Image Management/Reviewing)
	PENTAX PHOTO Laboratory (RAW Data Expansion/Conversion)

	Glossary

